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About Appvance

About Appvance

Appvance is the technology leader in and inventor of Al-driven autonomous
testing, which has revolutionized software testing.

Visit us at Appvance.ai.
Support

Contact our support team to request technical help, report an issue, or sug-
gest a new feature. See the Appvance Support page for more information.

Visit the Appvance Service Desk to submit a request.

Online Documentation

Visit the Appvance Documentation site for AlQ product documentation.

Training and Certification

Your journey to Autonomous Testing Engineer Certification (ATEC) starts
here. Take our classes and be among the very first to use and deploy the
world’s only Level-5 Autonomous software testing technology.

We offer self-paced classes, scheduled classes and tailored training. See the
Training and Certification page for more information.

Content Library

Explore the content library to access a range of resources to help you suc-

ceed in all your quality initiatives. Understand best practices, see examples of
success, and learn more about AIQ in action.



https://appvance.ai/
https://appvance.ai/support
https://appvance.atlassian.net/servicedesk/customer/portal/3
https://docs.appvance.net/
https://appvance.ai/training-and-certification
https://appvance.ai/content-library

About Appvance

News

Visit the Appvance Newsroom to read about our most recent announcements

and happenings.

Events

Connect with Appvance, learn more about AlQ, and engage in thought-pro-
voking conversations on delivering world-class software quality, autonomous
testing, and more.

See where you can meet up with the Appvance team.

Blog

Read the blog and learn about testing strategy & methods, Al, and get AlQ
product updates.

Contact Appvance
Online: Contact form

Email: info@appvance.ai

Phone: (845) 254-1164

Mailing address: 3080 Olcott Street Suite B240 Santa Clara, CA 95054



https://appvance.ai/news
https://appvance.ai/events
https://appvance.ai/blog
https://appvance.ai/contact-us
mailto:info@appvance.ai
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Appvance IQ 5.2.0 Release

The Appvance IQ (AlQ) 5.2.0 release includes a significant leap forward in the

world of Al-native automated testing. This release introduces Generative Al

V3, a comprehensive update that enhances performance, reporting, visual

object recognition, and bug-finding accuracy.

About this Document

This document contains information on the following functional enhance-

ments and functional changes in the AIQ 5.2.0 release.

"Al Script Generation in AlQ 5.2.0" on page 9

"Mobile Application Testing" on page 32

"Desktop Application Testing" on page 63

"API Testing" on page 94

"Functional Changes" on page 101

"AlQ 5.0.x Enhancements" on page 105

Depending on what AlIQ release you are upgrading from to AlQ
5.2.0, there may be additional functional enhancements
included in this release. For your convenience, information
about the enhancements in the AIQ 5.0.0 release has been
added to this document. See "AlQ 5.0.x Enhancements" on
page 105 for more information.
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Accessing AlQ 5.2.0

Appvance customers can access the 5.2.0 release page. The release page
includes a link to the AlQ 5.2.0 installer, the list of fixes included in the
release, information on upgrading from a previous release of AlQ and other
implementation considerations.

See the "Upgrading your Controller and Test Nodes" section of the 5.2.0
release page for upgrade information.

& See "About Appvance" on page 5 for contact information.



https://appvance.atlassian.net/l/cp/j7XvXA5Q
https://appvance.atlassian.net/l/cp/j7XvXA5Q
https://appvance.atlassian.net/l/cp/j7XvXA5Q
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Al Script Generation in AlQ 5.2.0

User Interface and Terminology Changes

The AIQ 5.0.x menu option Blueprint Designer has been renamed to Al

Script Generation in AlQ release 5.2.x.

8 Web Testing >

0 Mobile Testing >

o8 Desklop Testing >

& Autonomous Testing v

Al Script Generation About Web Application About Mobile Application About the Scenario Editor About Reports About Autonomous Testing

Testing Testing

Coverage Map

& AP Test Designer 8 statistics

A Last Test Summary

In addition to this change, the terms “Al Exploratory Testing” and “Al Blue-
printing” are no longer used. Those functions are now referred to as “Autonom-
ous Testing” and “Al Script Generation” (AISG). The user interface and
documentation will be updated to reflect these changes.

The term "Blueprint" is still used to refer to the Blueprint (.abpt) file that is cre-
ated during an AISG execution.

New Features and Enhancements

In addition to the following new features and enhanced functionality, there
were also extensive improvements to the Al Engine that powers AISG.
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e "New Coverage Map Types" on page 12

e "Search and Filtering Improvements on the Coverage Map" on page 15
e "Visual Accessors in AISG" on page 19

* "Al Training Enhancements" on page 25

e "SmartTag Visual Details" on page 28

« "AWS Instance Test Node" on page 29

Upgrade Considerations

* "Updating 5.0.x AISG Files to AlQ 5.2.0" on the facing page

e "Considerations for Custom Actions and SmartTags" on page 30

-10 -



Al Script Generation in AlQ 5.2.0

Updating 5.0.x AISG Files to AlQ 5.2.0

For the new features introduced in AlQ 5.2.0 such as the new Coverage Map
types and Visual Accessors you must rerun any existing 5.0.x executions on
5.2.0 to take advantage of these new features.

For example, while you can open a 5.0.x Blueprint file (. abp) in AlQ 5.2.0, the
new Coverage Map types will not be available automatically. The new Cover-
age Maps will only be available after the AISG execution is run using

AlQ 5.2.0.

You can either add a new execution or export a Blueprint file to a template
and create a new AISG from the template.

See Add an Execution or Al Script Generation Templates for
more information.

-11 -
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New Coverage Map Types

AlQ 5.2.0 contains significant improvements in the AISG Coverage Maps.
You can now select from three different dynamic visualizations of the Cover-
age Map.

* Original
¢ Extended Potential
¢ Actual Path

You can use these Coverage Maps to effortlessly track the AISG execution’s
journey through the application being tested, leverage Al hints more effect-

ively, and generate precise test scripts to replicate issues.

&

To take advantage of the new Coverage Map types you must
rerun any existing 5.0.x executions on 5.2.0. You can open a
5.0.x Blueprint file (. abpt) in AlQ 5.2.0 but the new Coverage
Map types will not be available automatically.

How are the types of coverage maps different?

The Original and Extended Potential coverage maps show you where
the Al can go from one page to another, however it does not mean that
the Al followed that exact path.

The Extended Potential coverage map is an enhanced version of the Ori-
ginal coverage map. It shows more information such as more page
states and page relationships. This can show you relationships that the
Al did not actually navigate, but learned about during the execution.

You will see more states and page relations on the Extended Potential
coverage map than on the Actual Path coverage map. This is because

-12 -
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even though the Al didn't explore this, it is aware that those relationships
exist.

e The Actual Path coverage map shows you the exact path that the
Al followed through the application. This will let you track the Al training
process and help you make further decisions on training the Al.

Original

This is the default visualization of the coverage map. It is the view that has
been used in previous versions of AlQ.

= 4 appvance o
% H

+ New. ©3 Open [¢] save - | [[) Blueprint006.abp &

sssss

Extended Potential

The Extended Potential view of the Coverage Map shows you the potential
path the Al traveled to reach a particular page state. This view is similar to the
Original view of the Coverage Map, but contains more states and page rela-
tionships.

-13-
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@ Home + New. 0 Open [ save - () Blueprint006.abp o
WK WebTesting > < Overview | CoverageMap —Execution1 - - Extended Potential Path +
0 MobieTesting >
> s —$— =3
Z - -~ — — 3
D E—
> . —
- —% °
. . . .
g . N .
- ~———3 3 .
/ -3
/ ° *—
/ P— [epr—
/ I —1 [Iclick on InkCs View detais{])
1) -~ ——3
> R // / . -~ ——3
/ = o e | Acton Detis requests €D
il Reports Y /4 N - - 8
./ g . . - .
= Testoata > < - - H N
A : —1 ° . i ¢ detail
Al Trafic . = I ——
AN P PR g Generate DS Script
& Global Options > p . -
——— . - 3
BE Tutorials /References > e
X . . - .
. —3
>~ —31 . .
-— -3
P— -~ —3
~—  } . .
. . . b—
- — —— ——g
. . . .

Actual Path

The Actual Path view of the Coverage Map shows the actual path that the Al
took when navigating the application under test. You can use this to track the
Al training process and help you make further decisions on training the Al.

From the Actual Path Coverage Map, you can now accurately generate DS
scripts that will contain the exact paths followed by the Al.

@ Home + New. £ open (dswe - | () Blueprinto06.abp °
B WebTesting > < Overview | CoverageMap Execution 1 - v ActualPath
[ Mobile Testing > State
https:/appvance.ai#/contact-
.
>
.
>

. .

. . .

- . .

s @

il ts / . .
= Testbata > [

. . o
al  Traffic
' Global Options >
b P . . .
WA Tutorials /References >

. . . . .

. . . . .
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Search and Filtering Improvements on the Cover-
age Map

Improvements have been made in the Coverage Map to allow you to search
and filter the results so you can explore the data more easily and efficiently.

Searching the Coverage Map

You can search the URLs in the Coverage Map. Click on a result to see the
page state details.

News a

URL: /news Action: link("News")

URL: /news Action: link("info@appvance.ai')

Filtering Requests

You can now filter out specific requests or errors (404 errors, etc) from the
Coverage Map. This action will be saved to the Blueprint (. abpt) file so that
the requests will not display when the Blueprint is executed in the future.

When you hide a request on a particular node, that request will also be hidden
for every other node that also has the same request.

Hiding a Request

 Tohide arequest on a node, right click on it from the list and select Hide
URL. The request is filtered out of the list and added to the Hidden
Requests list.

-15-
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™ | T

200 get https://demosit ... jpeg?1527769339
200 get https://demosit ... jpeg?1527769342
200 get https://demosit ... jpeg?1527769325
200 get https://demosit ... 230920145353.js
404L‘§t https://demosit ... jpeg?1527769324
/fdemosit ... jpeg?1527769324
s://demosit ... =hcknujxx&end=1
zowger-nups://demosit ... 5318b67ceff.css
200 get https://demosit ... 9be4363ddc1.png
200 get https://demosit ... c040ef11c.woff2
200 get https://demosit ... jpeg?1527769343
200 get https://demosit ... pvance.net:443/
200 get https://demosit ... jpeg?1527769327
200 get https://demosit ... jpeg?1527769328

Hide URL

e To hide arequest from the Requests list, select Hide Request from the
Action menu (the three dots).

< ovenview | Request [} Reached Domains  ignored URLs  Hidden Requests
Method Request U Status  Duration  Action
GET hitps/ = 21 fminifror_tote jpea/71527769324= 04 soms | [
POST hitps://demosite.appvance.com:443/orders/populate/? 302 221ms | Hide URL
PosT psi appvance com:443/orders/populate/? 302 191ms

POST 302 27
POST 302 154

POST 302 165ms  ee
POST 302 250

PoST 302 260ms  eee
POST 302 249ms e
POST 302 197ms

PoST 302 210ms e
POST 302 160ms  eee
POST 302 241

POST https://demosite appvance.com:443/orders/populate/? 302 237ms  eee

Viewing Hidden Requests

You can always choose to display all requests for a node have been hidden,
or a list of all requests for the AISG execution that have been hidden.
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To view hidden requests on a selected node:

1.

On a node, click the Requests tab.

State
https:/demosite.appvance.net//

Action Details 1 Rque*‘Ftse
Hidden Requests

200 get https://demosit ... t?variant_id=11
200 get https://demosit ... jpeg?1527769340
200 post https://demosit ... =hcknujxx&end=1
302 post https://demosit ... orders/populate
200 get https:/demosit ... y-on-rails-tote

200 get https://demosit ... jpeg?1527769338
200 post https://demosit ... shcknujxx&end=1
200 get https:;//demosit ... .png?1527769335
200 get https://demosit ... et:443/products
200 get https://demosit ... jpeg?1527769326
200 get hitps://demosit... 48a19a26c362 js
200 get https:;//demosit ... jpeq?1527769337
200 get https:/demosit ... ucts/spree-tote
200 get hitps://demosit ... cormerlogo.png
200 post https://demosit ... =hcknujxx&end=1

'y
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2. Click Hidden Requests.

State
https:/demosite.appvance.net//

R W S W o

Action Details 1 Requests @

\Il Hidden Requests

404 get https://demosit ... jpeg?1527769324
404 get https://demosit ... jEeg?‘I 527769324

net:443/spree/products

.appvance.
/21/product/ror_tote jpeg?1527769324

To view all hidden requests for the AISG execution, navigate to the

Requests page, and click Hidden Requests.

< Overview | Request All Reached Domains Ignored URLs | L EEETEEE

Method Request M Status Duration  Action
GET https://demosite.appvance.com:443/spree/products/21/mini/ror_tote.jpeg/?1527769324=& 404 36 ms
GET hitps://demosite.appvance.com:443/spree/products/21/product/ror_tote jpeg/?1527769324=& 404 62ms

-18 -
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Visual Accessors in AISG

AlQ 5.2.0 has significant improvements in element-bounds for visual hints
and the addition of Visual Accessors. Visual Accessors will be automatically
captured when elements have fewer than four fallback accessors. In addition
to the automatically captured Visual Accessors you have the option to manu-
ally create Visual Accessors for any element. You can also manually create
them from scratch if needed.

For general guidelines on using Visual Accessors see When to
use Visual Accessors?

Enabling Visual Accessors in AISG

Enable the Visual Accessors toggle in the Advanced Setup in the Al Script
Generation configuration for the Al execution.

v Advanced Setup

Self Healing

J® Shadow DOM

Validations Library

Network Library

Al Hints

Web Designer scripts to be used as hints for the Al

Files

Additional resources used in the Al

See the Advanced Setup Options section for more information
on the available options.

Example

This example shows a situation where only three fallback accessors were
identified, so a Visual Accessor was automatically added by the Al.

-19-
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Visual Accessors are added at the end of the list of fallback accessors. This is
for performance reasons. If AISG is able to match an element ID, it prefers to
use that over a Visual Accessor. Using a Visual Accessor will slow down
AISG, soitis used as a fallback accessor not as a primary accessor.

< Pages  Blog State

Custom Actions n wwaonn @) | all

+ Create Custom Action 4 Add Custom JS
Actionable Elements

action | with absolute XPath /htmi

TR  Element Actions

AbsoluteXPath  byXPath(/html)

RelativeXPath  byX himi1))

XPath  byXPath(//h
o -

Visual Accessor

Manually Adding a Visual Accessor

Visual Accessors can be manually added. Here is a basic example of the pro-
cess.

1.  Navigate to a page state and select the element for which you want to
add a Visual Accessor.

= & appvance o

2. Click Add Visual Accessor.

-20 -
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3. The Reference Image Properties window opens. From here, use the
cursor to select your Visual Accessor.

Reference Image Properties

Cancel Apply

4. Click Apply when you are done. The Visual Accessor is added.

Adding a Visual Accessor to a Custom Action

Visual Accessors can be added to Custom Actions. This is for situations

where If you want to create a Visual Accessor for an element that was not
identified by AISG.

Here is a basic example of the process.

ﬂ See Creating Custom Actions for general information on
adding Custom Actions to resolved failed actions in AISG exe-
cutions.

1. Navigate to the Page State for which you want to create a Custom
Action.

2. Click Create Custom Action.

-21 -
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% appvance

v

Il
‘

@ tom + [0 8302024 FromTemplate.abp °
- e >

< Pages. | Caogores - Cloting- Appranco Damo o Siste2 | 7
0 MobieTestng >

Gustom Actions, [N Unknown
- ; L) I —
) 3

— R

P
P n oA n
R

3. Select Visual Accessor and click Next.

< Pages

navigation

navigation

navigation
navigation
navigation

select

navigation

navigation

with id taxon (&3

Categories - Clothing - Appvance Demo Site State 2

form | with text All departments Bags Mugs Clothing

action | with value Search

with text Spree Ringer T-Shirt

with parent link(0, _in(div("product_4")))

navigation | with text Clothing[1]

with text Apache

with text Spree

with text Ruby on Rails Jr. Spaghetti[1]
Unknown input

with text Spree Baseball Jersey

with text Home

1 ™

O00O0OO0OO0ODO0ODOO0OO0ODOoOOoODOoOTt

Execute JavaScript

Visual Accessor

4. Click Select Visual Accesor.

-22 -
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< Pages | Categories - Clothing - Appvance Demo Site Stare2 (7]

centioted L —— ]

—_— .

R 2 R 7

A on oA

b ‘Select an element to see details

The Reference Image Properties window opens. From here, use the

cursor to select your Visual Accessor.

Reference Image Properties

you are done.

In the Set Value drop down, select Click.

New Custom Action
Pick the order in which actions should be done

Value required

SetValue =

Ruby on Ralls 835t Assert Contains Text

"""""" [ & ]

4+ Add Visual Accessor Action

| Back ‘ Create and Execute

Click Apply when

-23-
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7. Enter a name for the new Custom Action.

8. Click Create and Execute.

-24 -
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Al Training Enhancements

The following enhancements have been made to the AISG user interface to
allow you to easily add additional resources and data to further train the Al on
your applications.

Try All Option added to Custom Actions

The option to Try All has been added to Custom Actions. Custom Action can
be created to resolve failed actions that occur during the AISG execution.

New Custom Action
Pick the order in which actions should be done

with id taxon Try All -

Set Value
Back Create and Exe

Try All

Gx See Creating Custom Actions for more information.

Add Additional Resources

You can add additional resources to be used by the Al during the AISG exe-
cution. For example, you can add files that are required to be uploaded during

-25.-
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the test. You can also upload any files needed for any required SQL pro-
cessing during the test.

Resource files can be added in the Advanced Setup options in the Al Script
Generation configuration for the Al to use them.

ﬂ\ See the Advanced Setup options section in the documentation.

Support for Multiple Data Sets

You can add multiple data sets. There is a drop down where you can select
the type of DPL that you are adding.

Add Execution

Datasets

[ use a single dataset for multiple browsers
Default

Type

demosite_login (1). X
Hash DPL +

Type

testJS.csv-93416a¢ X
Hash DPL

Hash DPL
+ Create New <+ Import Ney

JavaScript DPL

SynthetiCDPL
= -
Encrypted DPL

You can select from:

Hash DPL
JavaScript DPL
Synthetic DPL
Encrypted DPL
Encrypted Hash DPL

-26 -
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G‘L See Add an Execution for more information.

-27-
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SmartTag Visual Details

You can now view details about the SmartTags that were found during the
AISG execution.

If you click the SmartTags button from the Blueprint Overview, you can see
details of the SmartTags within your Blueprint.

— )
= /Jbappvance o
@ Home + New. (3 Open [ Save -  [[f) smtag.abp <]
B Web Testing >
< Overview = SmartTags Execution 1 - Found  Not Found [¥) Export SmartTag Library
[J  Mobile Testing >
text| &) SmartTag stField 8 Rules
Navigation stProducts Click Thumbnail Image to see Details
navigation| & SmartTag stProducts 5 attrcontainsValue itemprop = name
® Autonomous Testing >
text| € SmartTag stUser 2 Extractions
None
& AP Test Designer =
- & text| €@ SmartTag stPassword 2
— Validations
. e
= Services Workbench navigation| @) SmartTag stLogin g None
S&  Scenario Editor Pages Found
F———
. Categories - Shirts - Appvance Demo Site
P Run Scenario b4 https://demosite-k8s.appvance.net/t/shirts
ttps://demosite-kBs.appvance.net/t/shirts
il Reports ]
= Categories - Shirts - Appvance Demo Site
= TestData > https://demosite-k8s.appvance.net/t/shirts
al Traffic [mm—=_Categories - T-Shirts - Appvance Demo
> H Site
n hitps://demosite-kBs.appvance.net/t/t-shirts
&' Global Options >
—— -

The Click Thumbnail Image to see Details link will show you a visual rep-
resentation of where the SmartTag was found.

@ Home + New.. © Open [] Save - | [[§) smtag.abp L
B Web Testing >
< Overview = SmartTags Execution 1 - Found  Not Found [¥) Export SmartTag Library
() Mobile Testing >
text| &) SmartTag stField 8 Rules
Navigation stProducts ST Q
navigation| & SmartTag stProducts 5 ¢

attrContainsValue itemprop = name

® AutonomousTesting >
text SmartTag stUser 2 Extractions
None
& AP Test Designer —
= & text| €@ SmartTag stPassword
— Validations
"y
&= Services Workbench navigation| @@ SmartTag stLogin 8 None
S scenario Editor Pages Found
———
= Categories - Shirts - Appvance Demo Site
v
> RunScenario https://demosite-k8s.appvance.net/t/shirts
th  Reports —
= Categories - Shirts - Appvance Demo Site
= TestData > [N ) hitps://demosite-k8s. appvance.net/t/shirts
al  Traffic fm———=_Categories - T-Shirts - Appvance Demo
> 5 Site
R https://demosite-k8s. appvance.net/t/t-shirts
£ Global Options >

-28 -
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AWS Instance Test Node

The Add Execution windows has a new test node option in AlQ 5.2.0. You
can select an AWS instance as your test node.

Add Execution

Execution Name Start with  Browser
Execution 1 1 Chrome ~ Headless Browser
Test Node

AWS Instance

Cloud configuration file is not selected W8 Select File

Required
Datasets

[[] Useasingle dataset for multiple browsers

Default

+ Create New + Import New

Cancel m

When you select AWS Instance you must select a cloud configuration file
that contains a link to the Test Node on which to run the blueprint.

-29-
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Considerations for Custom Actions and
SmartTags

If you are using SmartTags within an AISG execution, there is a limitation for
the PROP SmartTag when creating Custom Actions. The PROP SmartTag is
currently designed to ignore the element on the page. This means than an ele-
ment will not be picked up.

& The PROP SmartTag is like "null", but it is used in parent
SmartTags to create references.

Example

If you have a PROP SmartTag and you are trying to create a Custom Action
with only that SmartTag, the Custom Action will fail because there are no
associated elements. This is a known and expected limitation in AlQ 5.2.x.
Any other SmartTag type (Navigation, Action, etc) will work as expected when
creating a Custom Action in AlQ 5.2.0.

The workaround is to change the SmartTag to an action (once per app) or
remove the SmartTag.

CF A future release of AlQ will restore the element association and
remove this limitation.

AISG Repository Considerations

Git is not recommended for use with AISG. If your AISG executions are
extremely large and contains a large amount of images, you may eventually
see performance issues if you are using Git. The size limitation for Git is
around 100MB.
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Once you exceed 100MB, you may want to consider using an S3 repository.
This is due to Git not being designed to efficiently handle large amounts of bin-
ary files. Images are resource-consuming elements at the disk, memory, and
CPU level, so using an S3 repository will yield the best performance. This is
because the images will be saved with the script in your S3 repository which
simplifies image management.

If you are going to use Visual Accessors, you must use a SFTP, FTP, or S3
repository. Appvance does not recommend using Git to store your images if
your are using the Visual Accessor functionality. Again, this is due to Git not
being designed to handle large amounts of binary files efficiently.

& These guidelines were introduced with the AlQ 5.0 release.
This is a reminder.
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Mobile Application Testing

There are major changes and enhancements to the user interface for cre-
ating, maintaining and executing mobile tests in the 5.2.0 release of AlQ.

The new Mobil Designer interface aligns perfectly with modern editor cap-
abilities offering a more flexible and intuitive user experience that makes test-
ing tasks easier and more efficient. The new Mobile Designer user interface is
similar to the new Web Designer user interface that was introduced in AIQ
release 5.0.0.

is document is meant as a quick start guide to help acquain

& This d ti t ick start guide to hel int
you with the new Web Designer and explain the basic com-
ponents in the interface.

& Going forward the Mobile Designer (Classic) user interface is
frozen. All new features and functionality will only be imple-
mented in the new Mobile Designer interface. Mobile Designer
(Classic) will be depreciated and removed from AlQ in a future
release.

For more information on the new Mobile Designer see the following sections:

* "Mobile Designer - New User Interface Overview" on the facing page
* "Repository and File Manager in the Mobile Designer" on page 36
* "Mobile Configuration" on page 40

* "Mobile Designer Editor Options" on page 46
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Mobile Designer - New User Interface Overview

See an introductory video showing the new Mobile Designer

interface in use.

To access the Mobile Designer, from AlQ navigate to Home > Mobile Test-

ing > Mobile Designer.

This is an example of the new Mobile Designer interface.

3 L * Y v B

Overview of Mobile Designer Controls and Icons

Icon / Control

Function

Repositories e Repository pane. Displays the
v @ PublicDemo < contents of your repository. You
@ Blueprint . . .
) _ can sort and filter using various
> [l Config Files
> il Demo01 controls.
O = Repository / Quick Access

toggle. Switches the File Man-
ager pane between the repos-
itory and quick access views.

-33-



https://iq.appvance.ai/aiq-mobile-designer-video-0
https://iq.appvance.ai/aiq-mobile-designer-video-0

Mobile Application Testing

Icon / Control

Function

Filter. Allows you to filter the
items displayed in the File Man-
ager.

Sort by Name / Sort by Type.
Sorts the contents of the File
Manager pane by name or by

type.

Refresh Repository. Refreshes
the display of the File Manager
pane.

[ save

Editing controls menu.

e Save
e Undo
¢ Redo

| Save As...

Export to JavaScript

Additional save and export
options menu. Lets you

e Save as

* Export to JavaScript

[ File Manager

File Manager toggle.
Shows/hides the File Manager
pane.

-] console

Console toggle. Shows/hides
the Console

[1] "iPhone 14 Pro"

Mobile Device selection control.
Controlled by the mobile con-
figuration that you created for
your test.
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Icon / Control

Function

See "Mobile Configuration" on
page 40 for more information.

Test controls.

Record

Play
Skip Step

* Pause

* Stop

Open Test Options menu. See
"Mobile Designer Test Options
Details" on page 49 for more
information.

Mobile Config

Menu bar for interacting with a
Mobile Configuration file.

@ SzlectFile.. [$] Make Relative '

You can:

* Select a configuration file
* Make the file path relative
* Preview the json con-

figuration file

See "Mobile Configuration" on
page 40 for more information.
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Repository and File Manager in the Mobile
Designer

This section details the controls and options available in the Repository and
File Manager pane (highlighted) of the Mobile Designer interface.

o TSN EEET

Repository / Quick Access Toggle

Switches the File Manager pane between the repository and quick access

views.
n x
Repository Pane

Displays the contents of your repository. You can sort and filter using various

controls noted below.

Repositories e
~ il Publichemo o

> [l Blueprint

> [l Config Files

> il Demo01
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File Type Icons
The following icons display before the file names to indicate the test type.

« [J:Mobile test file (.mds)

. : JavaScript test file (.js)

The following test type icons and files are hidden in the Web Designer
because the context is invalid.

. : Web test file (.ds)

ap1 : APl test file (.api)

Filter

Allows you to filter the items displayed based on your search criteria.

Sort Toggle

Sorts the contents of the Repository File Manager pane by name or by type.
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v Sort by type

Sort by name

All Files
Web Tests

v Mobile Tests
Desktop Tests
APl Tests
Test Data
Smart Tags
Validations
Scenarios

Blueprints

Refresh Repository

Refreshes the display of the File Manager pane.

o

Create New

Shortcut to create new test files.

} Create New

JavaScript Test

Mabile Test

Import Postman...

Import File...

Available options:
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Mobile Test
Javascript Test
Import Postman

Import File
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Mobile Configuration

A mobile configuration file contains all the necessary configuration inform-
ation that is needed when testing a mobile application.

This topic describes the Mobile Configuration page in AIQ
release 4.9.4 and later.

1.  Navigate to AIQ > Home > Mobile Testing > Mobile Config.

e Click New to begin creating a new mobile configuration file.

e Click Open to open an existing mobile configuration file.

 appvance

L o)
]
e

Capabilities

Platform and Service
Service

Source. Device
/////

Home + New £ Open [ Save [ SaveAs
Web Testing > ma
latf
I
1

[=]

sssss

oo ol

v ¥

L

Platform and Service

Use the Platform and Service area of the page to define the basic para-
meters of your mobile configuration. Some options are only available in cer-
tain configurations. The page will update to show you the available options

based on what you have selected.
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Platform and Service

Service Platform Source
On-Premises - Android (Native) - Package -
Package

com.amazon.mShop.andr
Starting point to test your application (required)
Activity

com.amazon.mShop.deta
Starting point to test your application (required)

Allowed Domains
Add

Service

Valid values are:

¢  On-Premises

e BrowserStack

e Sauce Labs

. LambdaTest

Platform

Valid values are:
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e Android (Native)
e iOS (Native)
Source
Valid values are:

 Package

* URL

Device
e Physical device
* Emulated device

Start URL

e  Starting point to test your application (required)

Bundle ID

e  Starting point to test your application. Required.
Package

e  Starting point to test your application. Required.
Activity

e  Starting point to test your application. Required.

Appium Server URL

e The URL of the Appium server that you are using.
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Allowed Domains

e Determines access to URLs that might normally be blocked.

Capabilities

Use the Capabilities area of the page to define the specific parameters of
your mobile configuration. Some options are only available in certain con-
figurations. The page will update to show you the available options based on
what you have selected.

Capabilities

Name Value

Required

platformversion 33

udid emulator-5554

deviceName device

Extra

noReset true - X

On-Premises Capabilities

e platformVersion - Version of Android or iOS installed on the device.
e udid

. deviceName
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e bundleld -iOS only. Application bundle ID. Application mut be installed if
the value for app capability is blank.

¢ xcodeOrgld -iOS only. Team ID.

e xcodeSingingld - iOS only. IPhone developer.

updatedWDABundleld - iOS only.

BrowserStack Capabilities

e browserstack.appium_version

e 0s_version - Version of Android or iOS installed on the device

¢ device - Model of the mobile device

¢ realMobile - True/False

e project
e build

* name
* app

SaucelLabs Capabilities

e platformVersion - Version of Android or iOS installed on the device.

e deviceName - Model of the mobile device.

e deviceOrientation - Orientation of the device. Portrait or Landscape.

* app - URL of the Android Package Kit (apk).
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LambdaTest Capabilities

e platformVersion - Version of Android or iOS installed on the device.

. deviceName - Model of the mobile device.

e deviceOrientation - Orientation of the device. Portrait or Landscape.

e app - URL of the Android Package Kit (apk).

* isRealMobile - Real device (True) or emulated device (False)

¢ noReset - Determines if the app state will be reset the session.
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Mobile Designer Editor Options

The following options are available in the Mobile Designer.

Available Actions

The auto assist feature will show you the list of available actions.

Jrction

- @ @ e

Start a new script execution

Edit Accessors

* Right-click with the accessor column to see the list of accessors for that
step. You can use the individual blue check boxes to toggle individual

accessors on and off.

e Click Edit Accessors to edit multiple accessors at once.
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Click byId("Gallery")

Click byId("Hrowse")

Scroll | . o
1d byId({"Browse")

Scroll |

8

¥Pathid byXPath( ™/ /XCUIElementTyp..

(<

w*Path  byXPath("//XCULElementType..

8

byX¥(2, 770)

8

Fredicate  byPredicate("type == "¥C.

(<]

Edit Accessors

Right Click Menu

ClassChain ~ byClassChain( "**/XCUIE1.

The following options are available from the right click menu in the test script

editor. Your cursor needs to be in the right most column of the editor to

access the right click menu.

* Show Quick Help
* Copy

* Cut

* Paste

» Extract to Included file
* Add Breakpoint

* Record From Here
* Add Step Below

* Add Step Above

* Add Description

* Disable Step

¢ Delete
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Show Quick Help

Extract to Included Files

Navigate To https://demosite.appvar

Set Value

Summary

Set form input value simulating text entry

Declaration

Set Value input(“form") =
‘string”

Description

Simulates text entry into html form elements
(text-box like elements and text-areas) The
sequence of events performed are: Focus,
Enter Text, Remove focus.

The value can be static value like string,
number. Or it can be previously stored
variable or even result of JavaScript call.
Also supports Key Press events as a part of

string: {{SHIFT}} {{HOME}} {{TAB}} {{ENTER}}

1ce . com/checkout/ ’C‘fJiSLI

SetValue emailbox("form-control title") = “test@ticket.co

scess[1]")
1
1013

= Scols

r0l4

-

You can extract the step to a separate test script.

Add Description

You can add descriptions for any and all steps in your test script. This lets you
document the important details such as a specific search operation or a login
details. Script descriptions are extremely useful for Appvance Support if they
are called upon to help with script debugging.

Navigate To https://demosite.appvance.com

Click span("Ruby on Rails Tote")

s

In all AIQ reports, descriptions will be replaced as the step

names.
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Show / Hide Descriptions

When a line of the script is highlighted, you can click the Description icon to
toggle the display of comments for that line.

s

Removing Descriptions

When a line of the script that has a description is highlighted, there is a
Remove Description option available fro the right-click menu. You can also
click the three dots to the right of the Description icon and select Remove
Description from the menu.

Mobile Designer Test Options Details

Use the Test Options screen to configure various options for your test script.

Script Execution

[ Enable Fallback Accessors

Playback and Recording

[J Visual Accessors
[J Enable Thinktime
[ xPath Search

[] Take Screenshot on Failure

[] Preserve logs
[J Enable Step Duration

[ video Recording

Cancel
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See "Mobile Designer Test Options Comparison" on page 52
for the differences in test options between Mobile Designer
and Mobile Designer (Classic).

Script Execution Options

Enable Fallback Accessors

You can enable the Fallback Accessors option so that AlQ keeps test running
if an accessor fails or has changed, by automatically choosing other available
accessors.

« If Fallback Accessors are enabled, AlQ will try one time for each
accessor. If an accessor fails then it will scroll down and again try again
each accessor one time and scroll until it reaches the end of the page or
reaches maximum number scrolls.

e The scrolling logic will scroll up to ten times, depending on what it loc-
ates. If it is not locating elements, it will stop before it reaches ten. If itis
locating elements, it will continue until ten.

e [f Fallback Accessors disabled, playback will function as it currently
does. Tests may fail if an accessor fails or has changed.

Playback and Recording Options

Visual Accessors

Visual Accessors are image based accessors which can be used to enhance
your test scripts in situations where traditional code-based accessors will fail.
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AlQ will capture an image of the website and then crop the surrounding bound-
aries of the element that you are working on. During playback it takes the
image and applies a feature based matching algorithm which creates a pat-
tern from the image and uses that to locate the image on the webpage.

Using a Visual Accessors means that AlQ is not only looking at just the code
elements in a page, the Al is also looking at the visual elements on the page.

See Visual Accessors for Mobile Testing for more detailed
usage information.

Enable Thinktime

- Think time options can be enabled or disabled depending on the require-
ments. Enabling think times will add wait for statements in between every
action performed from the designer script.

XPath Search

- There are several ways to identify an element on the webpage, XPath
search is one among them. When you record a use case with this option
enabled, under the Accessor list you will notice the XPath accessors of that
particular element as well. Disabling this option will not add any Xpath ref-
erences to that element being identified.

Take Screenshot on Failure

Determines if a screenshot is taken even if the script fails before we reach
that step where a snapshot was to be captured..

Preserve Logs

Determines if the logs should be cleared every time a script is played. This
option is diabled by default.
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Enable Step Duration

Determines if step durations are noted in the logs.

Video Recording

Determines if a video of the script is shown at the end of the script playback.

Mobile Designer Test Options Comparison

The implementation of Test Options is different between the Mobile Designer
(Classic) and new Mobile Designer interfaces.

e Test Options available in Mobile Designer (Classic)

Edit ~  Scripts ~

Accessor Preferences * | SmartTags

Display No.s Accessibilityld

Thinktime ()

XPath Search Predicate
ClassChain

Visual Accessors XPathAccessibilityld

W Dathld
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Test Options available in the new Mobile Designer implementation

Script Execution

[J Enable Fallback Accessors
Playback and Recording

[J Visual Accessors

[0 Enable Thinktime

[ XPath Search

[[] Take Screenshot on Failure
[ Preserve logs
[[] Enable Step Duration

[ video Recording

Cancel
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Image Injection

The set Camera Image function allows you to set an image to be used

when triggering the camera during a test. For example, you could use this to

inject a QR code into your test script.

Compatibility Summary

Service i0OS Android Requirements
Device| Sim- Device| Sim-
ulator ulator
On Not Not Not Sup- Update emulator set-
Premises| sup- sup- sup- ported | tings.
ported | ported| ported
Sauce Sup- Not Sup- Not Add capability: sauceL-
Labs ported | sup- ported | sup- abslmageln-
ported ported | jectionEnabled: true
Browser-| Sup- Not Sup- Not Add capability:
Stack ported | sup- ported | sup- enableCam-
ported ported | eralmagelnjection: true
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Lambda- | Sup- Not Sup- Not Add capability:
Test ported | sup- ported | sup- enablelmagelnjection:
ported ported | true

On-Premises

Available for Android emulators only when running AlQ locally.

When running AlQ on an EC2 we don’t have access to JAVA HOME envir-
onmental variable nor the local file system, hence we can’t override the emu-
lator settings.

Android Emulator Setup

1. From Android Studio open the Device Manager.

2.  Click the Edit button for the emulator that you want to use.

[ ]
m AlQ v AIQ v
Device Manager
Virtual Physical
Create Device
Device -

o Nexus 5 API 31

o Pixel 4 API 31 «
2 Android 12.0 Google Play | arm64

3. Inthe Virtual Device Configuration window, click Show Advanced
Settings.
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Virtual Device Configuration

Q Android Virtual Device (AVD)

Verify Configuration
AVD Name

The na

4. Inthe Camera section select VirtualScene from the drop down.

@ Android Virtual Device (AVD)

Verify Configuration

Back Camera

5. Click Finish.

Sauce Labs

Available for Android and iOS physical devices only. There’s support for nat-
ive apps only.

The config file’s capabilities need to include the following field:

"saucelLabsImageInjectionEnabled": "true"
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Sauce Labs' App Config

1.

Login into your Sauce Labs account.

2. Goto App Management.

3. Click the Settings button for the app you want to use.
4. Turn the Image Injection switch on.
Supported APIs

Android System Camera

For Android devices, there are multiple ways to capture an image, as

described in the Android Camera API developer documentation. AlIQ supports

the following:

* ACTION_ IMAGE CAPTURE Opens the system camera and notifies the

calling app when the image is taken.

e camera2 API: Everything is configured and handled from within the app.
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e cameraX: Leverages the capabilities of camera?2, but uses a simpler,
use case-based approach that is lifecycle-aware.

e Camera API (deprecated): partially supported. As with camera?2,

everything is handled in the app itself. QR Code readers often use Cam-
eraftsetPreviewCallback. We pass the injected image to this
method, but the rest of this deprecated APl is not supported. Ul Ele-
ments will not likely display the injected image.

iOS System Camera

ForiOS devices, the camera can be configured with different outputs.
AIQ supports the following:

e AVCapturePhotoOutput: for capturing stillimages. The results are
received via the AVCapturePhotoCaptureDelegateand the method cap-
tureOutput:didFinishProcessingPhoto:error: The other methods in this
delegate are either deprecated or handle live photos, which we don't
support.

e AVCaptureVideoDataOutput: for capturing video frames and pro-
cessing them. The frames are received via AVCap-
tureVideoDataOutputSampleBufferDelegate and the method
captureOutput:didOutputSampleBuffer:fromConnection:.

e AVCaptureMetadataOutputforreading QR-Codes. The QR Codes
are passed to the app via cap-
tureOutput:didOutputMetadataObjects:fromConnection:.
We are detecting the AvMetadataMachineReadableCodeObject
and QR Codes are part of that.

| G Sauce Labs documentation is available here.
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BrowserStack

The config file’s capabilities need to include the following field:

"browserstack.enableCameralImageInjection": "true"

Supported APIs

Camera image injection is supported for the following Camera APls. Check

with your app development team to get more details about the Camera APIs

your app uses.

oS OS ver- | Supported APIs
sion
i0S i0S 13 didFinishPickingMediaWithInfo API of UlimagePick-
and erController iOS SDK class for capturing an image.
above For more details, please check Apple
documentation.
AVCapturePhoto iOS SDK class for receiving cap-
tured photos from AVCapturePhotoOutput API. For
more details, please check Apple Documentation.
jpegStilllmageNSDataRepresentation of AVCap-
tureStilllmageOutput iOS SDK class. For more
details, please check Apple documentation.
Android | Android android.hardware.camera.PreviewCallback API for
6 and APl level 1-20
above

android.hardware.camera2.CameraManager,
android.hardware.camera2.CameraDevice, android-
.hardware.camera2.CameraCharacteristics, android-
.hardware.camera2.CameraCaptureSession,
android.hardware.camera2.CaptureRequest,

android.media.ImageReader APIs for APl level >=21
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Camera Intent API

Gx Browser Stack full documentation here.

LambdaTest

The config file’s capabilities need to include the following field:

"enableImageInjection": "true"

LambdaTest App Setup

1. Login to your LambdaTest account.

2. Go to App Testing under Real Devices.

3. Hover the Settings icon and toggle the Image Injection switch on.

Android

i0s

ﬁ B iPad

Sample App.ipa

SampleCameraAppLT.ipa

Image Injection

Supported APIs

Below given is the list of Camera APIs which are supported by LambdaTest

Image Injection tool. Please ensure that your app uses these APIs only to

enable Image Injection.

(0153 Devices | Supported APIs

i0OS i0S 13 didFinishPickingMediaWithinfo API of UllmagePick-
and erController iOS SDK class for capturing an image.
higher For details, please check Apple documentation.

AVCapturePhoto iOS SDK class for receiving cap-
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tured photos from AVCapturePhotoOutput API. For
details, please check Apple Documentation.

Android Android
9 and
higher

CameraX APl is used. For details, please check
CameraX Documentation

Camera APl is used. For details, please check this
link.

Camera2 APl is used. For details, please check this
link.

ACTION_IMAGE_CAPTURE is standard Intent
action that can be sent to have the camera applic-
ation capture an image and return it. For details
please check this link.

G\ LambdaTest full documentation here.
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Geo Location

You can use Geo Location for iOS and Android phones with Browser Stack,
Saucelabs, and On Premise testing. The Geo Location format is latitude and
longitude in decimal format.

MSavemUndo «o W Mobile > Pixel4API31 ¥ Readyto
[ N R &
Config {mds}/GoogleMaps-Android-Config... @@ SelectFile.. @ Preview
Data @@ SelectFile X %

+ Add Resource

Click byId("com.google.android.apps.maps:id/explore_tab_home_bot..

Set GeoLocation {"latitude":89.887, "longitude":-57.977}

Set GeoLocation {"latitude":55.76, "longitude"” :"43.67"}

Set GeoLocation {"latitude":46.54, "longitude" :-150}
D File Manager Log Viewer <> Elements [# File
07g.JSON.JSUNUD]ECT.geTUouDIe(JSUNUDJECT Javaros 1) ... 1o more

2024-85-01 15:32:03.859 Step 4: setGeolocation {’latitude":46.54,"longitude"-150} [Step Completed]

2624-085-81 15:32:45.872 Set Client Type Android

2624-05-81 15:32:53.539 start Starting Android Client

20824-085-01 15:32:56.686 Step 1: click com.google.android.apps.maps:id/explore_tab_home_bottom_sheet [Step Completed]
2024-85-81 15:32:57.602 Step 2: setGeolocation {’latitude™89.887 "longitude™-57.977} [Step Completed]

20824-85-01 15:32:58.186 Step 3: setGeolocation {’latitude”:55.76,"longitude":"43.67"} [Step Completed]

2024-85-01 15:32:59.001 Step 4: setGeolocation {’latitude’:46.54,"longitude"-150} [Step Completed]

All Output » | [y Download Log Q Filter cl
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Desktop Application Testing

Desktop Designer is a new testing interface that takes advantage of AlQ’s
Mobile Designer technology so that you can test desktop applications across
diverse environments, including Citrix. You can use Visual Accessors to cre-
ate new test scripts using simple as point-and-click. Fallback accessors and
self-healing script capabilities are built-in to help make creating robust and
resilient test scripts effortless.

& Here is a brief introductory video on the features and benefit of
Desktop Designer.

— - Co—

Benefits and Highlights

* You can your test scripts as a Scenarios and view the results on the
Dashboard.

* Record a video of the test script execution.

e Easy access to all Windows keys and actions.
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* Point and shoot to record your script or add the logic you need with the
use of Javascript commands

e Detachable preview mode allows you to work on two monitors. You can
view your test script on one monitor and the application on another mon-
itor.

Desktop Designer currently supports Windows applications
and mainframe systems. Support for Desktop Testing on other
operating systems will be added in future releases of AlQ.
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Desktop Designer User Interface Overview

To access the new Desktop Designer, from AlQ navigate to Home > Desktop

Testing > Desktop Designer.

{o appvance

® Web Testing >
ner Script Build a Scenario
0 Mobile Testing >
8 Tutorials / References
18 Desktop Testing v
Desktop Designer
JS Edit & Play Application Testing About Mobile Application Testing About the Scenario E
SmartTag Workbench
Validations Workbench & Swatistcs
Desktop Config
A Last Test Summary 8 Recent tests performed
3 Tesf
& Autonomous Testing > teration Name
& API Test Designer Success
Failures
& Services Workbench > )
Total Users
£ Scenario Editor
Avg hits/sec
Scena .
Lo (RS Total Throughput
. Reports Avg throughputisec
= o . v Cnciimad handwidth

Analyze Al Driven

About Reports How to create an AppPe
Tost

A System Status

Location C\AIQaiq_distribution!
TestNode Permission  Read | Write | Execute
Web Designer Server  Running

Running
DB Status
Appium Server Not Running
Load Runner Not Running

This is an example of the new Desktop Designer interface.

> appvance

Desktop001.dds
& services Workbench P ———
esktopTesto1.dds Click byName("Notepad, Desktop app")

Scenario Editor DesktopTesto2.dds

X

obileTesto1 Wait 10000
P Run Scenario

i Reports
= Testbata >

al Trafic [N

Global Options. >

BE Tutorials /References >

+ Create New

X showoptions @ Prev

@ Home [ S DesktopTesto1.dds
B WebTesting > [ save @8 Deskiop > CitrixDesktopApp ~
Mobile Testing > Repositories ©  contg (masy/Root234... m sl v

~ [ dsaiqtestrepo 4 Data {mds}/DesktopTest01/NotePadDPL... B t File

~ @8 Desktop0
- 9 Deskiopot + Add Resource
% AutonomousTesting > » B8 DeskiopTestol

Click byClassName ("TrayButton")

& APITest Designer > B DesktopTestoz Wait 5000

SetValue byAccessibilityTd("SearchTextBox")

SetValue byAccessibilityId("15") Sregistry

Readyto start @FRecord | B Play |~ o

1) Preview [ File Links
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Overview of Desktop Designer Controls and Icons

The following table provides an introduction of the various controls and icons

in the new Desktop Designer interface. The various elements are controls are
detailed in the following pages of this document.

Icon / Control

Function

Repositories
| dsaiqtestrepo
v [ Desktop01
> @A DesktopTesto1
> @8 DesktopTesto2
Desktop001.dds
DesktopTest01.dds

DesktopTest02.dds

e

Repository pane. Displays the
contents of your repository. You
can sort and filter using various
controls.

Q-

Repository / Quick Access
toggle. Switches the File Man-
ager pane between the repos-
itory and quick access views.

Filter. Allows you to filter the
items displayed in the File Man-
ager.

Sort by Name / Sort by Type.
Sorts the contents of the File
Manager pane by name or by

type.

Refresh Repository. Refreshes
the display of the File Manager
pane.

[ save

Editing controls menu.

e Save
e Undo
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Icon / Control

Function

¢ Redo

Save As...

Export to JavaScript

Additional save and export
options menu.

* Save as
* Export to JavaScript. See
"Desktop Designer Export to

Javascript" on page 78 for

an example.

(D File Manager File Manager toggle.
Shows/hides the File Manager
pane.

] Log Viewer

Log Viewer toggle.
Shows/hides the logs.

BR Deskiop > Citrix_DeskiopApp ~

Ready to start

Browser selection control. See
Selecting the Browser for more
information.

@ Record | p Play |~

Test controls:

Record

Play
Skip Step

* Pause

* Stop

Opens the Test Options menu.
See Desktop Designer Test

Optionsfor more information.

config W@ SelectFile...

Select Configuration controls.
You must have a valid desktop
configuration file selected
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Icon / Control Function

before you can begin a desktop
test. See "Desktop Designer
Configuration" on the facing
page for more information.

Data @B SelectFile.. X Select data controls. You can
attach test data to your desktop
test.

-68 -



Desktop Application Testing

Desktop Designer Configuration

All desktop tests must have a desktop configuration file associated with them.
This file contains all the necessary settings in order for the test to run. Con-
figuration files are assigned to desktop tests in the Desktop Designer. A
desktop configuration file can be associated with multiple desktop test files.

Create or edit a desktop testing configuration file
1. From AlQ navigate to Desktop Testing > Desktop Config.

= JSbappvance

Web Test . . -

B Web Testing ’ Configurations Platform and Service Capabilities

Service Platform E

[ Mobile Testing > Name Value
@@ Desktop Testing v Required

Package
Desktop Designer deviceName ~ Windows PC
oint to test your application (required) ——

JS Edit & Play

Extra

Appium
http://localhost:4723/wd/hub

Video Port

[ useProxy

Allowed Domains

2. Click Create New and name the file.

3. The parameters for Service, Platform, Source and Device are set by

default.

Platform and Service

Service Platform Source Device

-069 -



Desktop Application Testing

4. Specify the required parameters.
* Package specify Root
* Activity specify TEST
* Appium Server URL specify the IP address of the desktop

machine you will be testing

% appvance

@ Home + New €7 Open [ Save [ SaveAs DesktopConfig02
Web Testi " . aese
LRI > configurations Platform and Service Capabilities
Service Platform Source Device
O Mobile Testing > 2 X B - Name Value
DesktopConfig01 X
W@ Desktop Testing > Required
Package
+ Create New
W AtoromousTestng > - deviceName  Windows PC
& APITest Designer Starting point to test your application (required) L L0 M
Activit
Services Workbench i Lo
TEST

¥ W

Scenario Editor
Starting point to test your application (required)

e Appium Server Url
il Reports htpi/localhost:4723/wd/hub
Video Port
= Testbata >
al Traffc
[ use Proxy
& Global Options >

Allowed Domains.

Tutorials / References >
= ‘ Add ‘

5. Click Save to save your desktop configuration file to your repsoitory.

Save File As

~ Quick Access
Repositories ™

v @8 HoME 89 emptylnner 11/08/2023 16:43

> @@ _cico

= @8 ExcelDemoScript 02/02/202411:36
v HelloAppvance

» @ empyimer @ innerFolder 08/07/2023 1451
> @ ExcelDemoScript B Roow243TestTemplate 02/06/2024 16:46
> @8 innerFolder @ Rootseript 02/06/2024 09:46
> @ Root243TestTemplate | Exceljson 02/06/2024 15:08
> @8 RootScript

> @ RootDemoAppvance

| Rootjson 02/07/202414:27

> mobile (i
SERVER

pull
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Example Desktop Configuration File

]

}

"configName” : "Root_DesktopiApp”,

tappt: "7,
"appPackage”: "Root",
"bundleld": ""
"source”: "package”,

"deviceMode”: true,

"service”:

"On-Premises”,

"serverURL": "http://100.20.219.14:4725/wd/hulf|",
"platformName" : "Windows",

"appActivity": "TEST",

"validDomains": ""

"capabilities": {

}

"gystemPort": "8201",
"deviceName" : "WindowsPC",
"noReset”: "true”

s

This is the preview of the configuration file that you can view in

the Desktop Designer user interface.

s

See Mobile Configuration for more information about Mobile

Configuration files.
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Creating a Desktop Test

Here are the basic steps for creating a new desktop test file in the Desktop

Designer.

O

g Prerequisite: A desktop configuration file must be created
before you create the test file. See "Desktop Designer Con-
figuration" on page 69 for more information.

1.  In AlQ navigate to Desktop Testing > Desktop Designer.

2. Click Create New in the and select Desktop Test. You can also click
Create New Desktop Test in the main portion of the screen.

= Jdbappvance o
%) Home
i

3. Name the test file.

4. Onthe Config line, click Select File to add a desktop testing con-
figuration to your test. This needs to be a preexisting file. See "Desktop
Designer Configuration" on page 69 for more information.
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Desktop001.dds

SR Deskiop > Noavaliable configurations Ready to start &

Data @@ Sele
+ Add Resource

Action

Browse to the location of your configuration file in your repository and
click Open. Configuration files are . json files.

Open File
v Quick Access Name Modified Size
Repositories ]
v dsaiqtestrepo = @ DeskiopTestol 04/03/2024 21:44 0B
> @ Desktopmn @ DeskiopTestoz 04/03/2024 21:53 0B
’ i HosIeTEsen DektopConfig01 .-301 04/02/2024 19:08 1003.0B
04/02/2024 21:21 481.0B

RoOt234 json

Cancel

- E

You can click Preview to verify the details of the configuration file.

Ready to start @ Record | B Play |~ &

B8 Deskiop > Root_DeskiopApp ~

Config {mds}/Root4725__... W Select File

[
¢

"configName: "Root_DesktopApp”,
app™: *7,
appPackage”: “Root”,

"bundleld”: ",

mises”,
FURLY: "hetp:/100.20.219 1424725 ws/mu
platformiame”: “Windows®,
"appActivity”: "TEST",
“validDomains": "%,
capabilities”:
"systemPort”: "82817,
deviceName”: “WindowsPC”,
"noReset”: "true

You can now begin recording your test. Click Record to begin.
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See "Desktop Designer Example - Kindle Desktop App" on
page 80 for an example desktop test.
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Desktop Designer Test Options

The following options are available for desktop testing in the Desktop

Designer.

Test Options

Script Execution

Playback and Recording

[] visual Accessors

[[] Take Screenshot on Failure

[C] Enable Fallback Accessors

[] Enable Thinktime

XPath Search

[ Ppreservelogs
[J Enable step Duration

[ video Recording

Cancel

Script Execution Options

The following options pertain to execution of scripts.

Enable Fallback Accessors

You can enable the Fallback Accessors option so that AlQ keeps test running

if an accessor fails or has changed, by automatically choosing other available

accessors.
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» If Fallback Accessors are enabled, AlQ will try one time for each
accessor. If an accessor fails then it will scroll down and again try again
each accessor one time and scroll until it reaches the end of the page or
reaches maximum number scrolls.

e The scrolling logic will scroll up to ten times, depending on what it loc-
ates. If it is not locating elements, it will stop before it reaches ten. If itis
locating elements, it will continue until ten.

e [f Fallback Accessors are disabled, playback will function as it currently
does. Tests may fail if an accessor fails or has changed.

Playback and Recording Options
The following options pertain to playback and recording of scripts.
Visual Accessors

Visual Accessors are image based accessors which can be used to enhance
your test scripts in situations where traditional code-based accessors will fail.
AIQ will capture an image of the website and then crop the surrounding bound-
aries of the element that you are working on. During playback it takes the
image and applies a feature based matching algorithm which creates a pat-
tern from the image and uses that to locate the image on the webpage.

Using a Visual Accessors means that AlQ is not only looking at just the code
elements in a page, the Al is also looking at the visual elements on the page.

See Visual Accessors for Web Testing for more detailed usage
information.
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Enable Thinktime

Think time options can be enabled or disabled depending on the require-
ments. Enabling think times will add wait for statements in between every
action performed from the designer script.

XPath Search

There are several ways to identify an element on the webpage, XPath search
is one among them. When you record a use case with this option enabled,
under the Accessor list you will notice the XPath accessors of that particular
element as well. Disabling this option will not add any Xpath references to that
element being identified.

Take Screenshot on Failure

Determines if a screenshot is taken even if the script fails before we reach
that step where a snapshot was to be captured..

Enable Step Time Duration
Visualize step durations in the log files.
Preserve Logs

Determines if the logs should be cleared every time a script is played. This
option is disabled by default.

Video Recording

If enabled, it will show a video at the end of the playback.
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Desktop Designer Export to Javascript

You can export a desktop designer test file to javascript. This will make your

test script available for web testing. The javascript file is created with the
same name as your desktop designer test file.

For example, you have a desktop testing file named ContextMenu.dds.

b=l Conteximenu.dds I

(€] save D Undc

BN Deskiop > ExcelDeskiopApp ~

Ready to start @Record | B Play |~
Config {mds)/Excel_EC... W SelectFile.. ® Preview

Data @ Select File
+ Add Resour

Click byAccessibilityId(*4103°)
Send Keys “Notepad”

Click byName(“Notepad, Desktop app*)
Send Keys

Testing Context Menu

Click the additional options menu (...) and select Export to Javascript.

&) contextMenu.dds
(4] save D undo B8 Deskiop > Excel DesklopApp ~

Config {mds}/Excel_EC... | Save As pview

Data W@ Select File

Export to Ja\@cnpl X
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3.

The file ContextMenu.js is created.

&) ContextMenu.dds I JS ContextMenus I

W Vb ~ > @ Chrome «

1 setVariablesIfNeeded( ", HashOPL',0);
setConf iguration( ' {nds)/Excel EC2.json’, ‘Excel DesktopApp’);
start();
4 clickibyh
sendKeys
click(byNane
sendKeys(“Te

Ready tostart B Play
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Desktop Designer Example - Kindle Desktop App

Here is a basic example of creating a desktop test that interacts with the
Kindle desktop application.

This example will show:

* Creating a new Desktop Designer test script

» Starting the recording

* Launching the desktop application being tested
* |nteracting with the desktop application

* Creating Visual Accessors

* Creating an assert

* Exiting the application

» Editing the test script

* Playing back the recording of the test script

Example

1.  In AlQ navigate to Desktop Testing > Desktop Designer.
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Click Create New Desktop Test.

Create New Desktop Test

Name and save your new test script. In this example the file is named
KindleVideo.dds.

=4

; KIIldlEVIded dds

(4

.dds is the file extension for all Desktop Designer test
scripts.

Select a Desktop Configuration file. If you have not created a Desktop
Configuration file, see Desktop Designer Configuration Files for more
information.

Click Preview to see your Desktop Configuration file.

4 save indo eskiop > RootDesktopApp ~ eady o start ecor ay |~
save o Und Deskiop > Root_Desk Ready @Record | B Pl

Config {mds}/Ro0t4725__.. M SelectFile.. @ Preview

Click Record to begin recording your test script.
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S Kkndevideoes @ EEE

(g save B Undo -+ B Deskiop > RooLDeskiophpp v rasyom | @ fegga [Bro |- ] ©

o0ta725__.| @ select e @ Preview

N
© Not Secure 19-14.Us-west- t :8443/UI/V1/#/preview

Waiting for the device.

8. Right click the desktop icon for the Kindle app and select Double Click.

Preview

Assertion

Capture Target

Capture Visual Accessor
Deuh&lg:llck

Draw

Inspect

Input Actions

Right Click

Save File

Store Element Text

Window Controls

Drag

9. The Kindle desktop app starts.
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10.

11.

12.

Preview

Hover over one of the book covers
Visual Accessor.

. Right click and select Capture

Preview

E Kenneth's Kindle for PC

File View Tools Help

Q, Search your Ki

Ml Library
Books
Documents
Samples

00V coltections

Assertion

Capture Target

Capture Wal Accessor
Double Click

Draw

Inspect
ae

e | Input Actions v
Rigit Click
Save File
| Store Element Text

Window Controls v

Drag v

JACK MITCHE

Hug Your Custome... :
Mitchell, Jack &

B -
CUANDO SE MATA

QUE LOS VENDEL

V7

o
3= Filter »

g v very
Secrets

Millionaire

Mind

am.
h

of ¥ el
I. Harv Eker

Secrets of the Milli...

Eker, T. Harv

Select the boundaries of the Visual Accessor.

Click Save Target.

Tl Sortby: Recent » I3 View »

Hedgehog's
Hexcellent
Adventure

A LrsziE smorTLe
STORY

iyanne L -

Ever After High: Li... :
Selfors, Suzanne

MIRAGULOUS
MEDAIL
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Preview

ey - |

13. Click on the Visual Accessor.

14. Add Step with Double Click.

Preview

Cancel ‘ m With Click =

Click

DoubleClick
ngm?&k

Set Value

Set Value Enter
Assert Exists

Highlight
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15.

16.

17.

18.

In the Desktop Designer window you can see that the step has been

added to your test script.

@ KindleVideo.dds ®

[£] Save ' Undo «  BR Deskiop >

Data @ SelectFile..

+ Add Resource

Double Click

Action

Config {mds}/Root4725__ .. W@ SelectFlle.. & Preview

Double Click byAccessibilityld( "ListViewItem-8")

|

X

—a
- = .
e -

Click in the Search bar and then right click.

Select Input Actions > Set Enter Value.

Preview

B Kenneth's Kindle for PC - Hug Your Customers: STILL The Proven Way to Personalize Sales and Achieve Astounding Results

File view Go Tools Help

[ wom J<me @ [ewev|an | % |l O EB

ea a
. Assertion

Capture Target
Capture Visual Accessor

Double Click

ﬁln!!!
1

Draw

Inspect

Input Actions ~
Send Key Combination

Set Value E&a’

Right Click
Save File

Store Element Text
‘Window Controls

Drag v

0% Location 1 of 3546

Enter a search string. In this example the search

— [m] x

Show Notebook

YOUR

o) . CUSTOMERS. .

JACK MTITCHELL

string will be "Mitchell".
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19. Click Apply.

Preview

B Kenneth's Kindle for PC - Hug Your Customers: STILL The Proven Way to Personalize Sales and Achieve Astounding Results - [m] x

File View Go Tools Help

< S e~y | aa | x B M HB Show Notebook

a

1 [ Mitchell I Toir WALL STREET JOURNAL BUSINESS BESTSELLER

HUG

YOUR

. CUSTOMERS. .

Cancel

ﬁln!!!

JACK MITCHELL

0% Location 1 of 3546

20. The search results load.

21. Select one of the search results and right click. Select the Double Click
action.
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22.

23.

Preview

I Kenneth's Kindle for PC - Hug Your Customers: STILL The Proven Way to Personalize Sales and Achieve Astounding Results - (] x

File View Go Tools Help

[om <o © |con~| an | 3 | O HE R oo |

= Mitchell x
ﬂ 151 matches found “L1 Sraser Journai BUSINISS BESTSILLIR
You are here =
= _
the author's right Assertion or all that
you are—
Capture Target

Capture Visual Accessor

YOUR

DoublgClick
My family and | n Stores, a
L e CUSTOMERS
¢ . -
Inspect
Input Actions v atior
customers.” | tolg Right Click ryone from
the sales associal g0 i

Store Element Text

Window Gontrols ¥
the two stores in and
Drag v
Richards; Marshs

JACK MI1T

a small airplane. That's what Mitchells is about:
making people say.

0% Location 1 of 3546

The page associated with the search result loads on the Kindle screen.

Preview

EE Kenneth's Kindle for PC - Hug Your Customers: STILL The Proven Way to Personalize Sales and Achieve Astounding Results - o x

File View Go Tools Help

[ J<os © |wo~ | as | | (O HB R [ |

=5 Mitchell x
E L oy Connecticut, Mitchells and Richards; Marshs in
T venemebae ~ Huntington, Long Island; and Wilkes Bashford
(=] in San Francisco and Palo Alto. We do in excess

of $125 million a year, and we are all thrilled to
be selling suits and dresses one at a time and, of
course, hugging customers. We achieve much of
Page1 - Location 47 this volume in Westport, a town of just 28,000
My family and | run MitkBills Family of Stores, a people, and in nearby Greenwich, which has
D about 60,000. Roughly every other household is
a customer in our system, because at some
point we gave them a very pleasant and
customers.” | told how at Mitehells everyone from . .
the sales associate memorable shopping experience—a hug or two
that made them come back for more.
We’ve been told by others that we're one of
THR RS e I EANSCHAL, Mcistin anc the most successful—if not ##¢ most successful
Richards: Marshs in Huntington, . . - . .
—high-end clothing businesses of our size in the
Page 6 » Locatior country, and maybe in the world. It’'s not

the author’s rights. TO BILL MITCHELL For all that
you are—

Page S « Location 81

a small airplane. That's what Mitchells is about:
making people say.

—
3% Page5of318 - Location 91 of 3546

Hover over the page and right click. Select Capture Visual Accessor.
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24.

25.

26.

Preview

Capture Visual Accegoy

1B

File Vview Go

Tools Help

Mitchell x

151 matches found

You were here

the author’s rights. TO BILL MITCHELL For all that
you are—

My family and | run Mitchells Family of Stores, a
profitable

customers.” | told how at Mitchells everyone from
the sales associate

Page 5 - Location 91

the two stores in Connecticut, Mitchells and
Richards; Marshs in Huntington,

a small airplane. That's what Mitchells is about:
making people say

Bashford" that is selected.

Click Save Target.

-

Add Step with Assert Exists.

B Kenneth's Kindle for PC - Hug Your Customers: STILL The Proven Way to Personalize Sales and Achieve Astounding -

Double Click
Draw o o
Inspect
Input Actions. v

B M &S
Right Click
Save File

Store Element Text . .
ichards; Marshs in
Window Controls v

Connecticut, Mit

Huntington, Lon d wilkes Bashford
in San Francisco _ —_ _ ___ ___‘o. We do in excess
of $125 million a year, and we are all thrilled to
be selling suits and dresses one at a time and, of
course, hugging customers. We achieve much of
this volume in Westport, a town of just 28,000
people, and in nearby Greenwich, which has
about 60,000. Roughly every other household is
a customer in our system, because at some
point we gave them a very pleasant and
memorable shopping experience—a hug or two
that made them come back for more.

We've been told by others that we're one of
the most successful—if not #%Ze most successful
—high-end clothing businesses of our size in the
country, and maybe in the world. It's not

Drag

3% Page50f318 - Location 91 of 3546

Adjust the Visual Accessor target. In this example it is the text "Wilkes
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Preview

Cancel

27.

Add Step  With Double Click =

Click
Double Cliek
Right Click.

Set Value

Set Value Enter
Assert Exists

Highlight

Wilkes Bashford

The test script updates in the Desktop Designer window.

B8 Deskiop > fioot

pApp w

Config {mds}/Rootd725__ .. @8 SelectFile.. & Preview
Data M@ SelectFile.. 3% Shov 1 ; VX
+ Add Resource

| Double Click byAccessibilityId("ListViewItem-8"
o g i "

Click byAccessibilityId("ReaderMainWindow.cen

Double Click

4 SetValue Enter byAccessibilityId("ListViewItem
Double Click byName("the two stores in Connect

Assert Exists

Action

28.

You can see more information in the Log Viewer tab.
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29.

30.

31.

® Kndevideodds @
@ swe D tndo B Deskop > ecrang > 5 pase | Wsop | @
Confg (mds)/Roota725_... W Selectle.. @ Previen
Data 0 SelectFe x
+ AddResource
Double Click_ bykccessibalatyId(“ListVienIten-8")
Dousle clck
i b
SetValus Enter byAccess1bi1tyId("ListVienTten-87) “Hitchell”
Double Click byName("the two stores in Comnecticut, Mitchells and Rich.
Assert Exists
o e ) LogViewsr > Elements @ File Lo
024-06-69 13:06:32.172  Execuion Sried
2024-06-09 13:06:34.021 SetClent Type Windows ‘ool Deskiophpy
2024-06-09 12:06:41.114 Windows Clent
2624-06-09 13:06:41.114 ned. You ca record
2024-06-09 13106156052 & (step Completed]
2624-06-09 13:08:11.179. Suep2: doublecick Image [Step Completed]
2624-06-09 13:08:24.5%2  Sep?: clek
2624-06-09 13:08:55.151 St & setValueEnter “Michel®” itVewtem Michel” (Step Completed
40609 1310931 202 50 it Y Morshs o Huntigton,
2624-06-09 13:10:21.622  Step 6 assenErks Result e, Success - assentExats ssaentiats success - mage [Step Complted
Click in the TOC and select Title Page
Preview
B Kenneth's Kindle for PC - Hug Your Customers: STILL The Proven Way to Personalize Sales and Achieve Astounding Results [m] x

File view Go Tools Help

L\bra% < Back “er-)

Table of Contents

Goto ¥

Q Cover

= Title Page
Welcome
Dedication

PREFACE TO THE 2015 EDITION
PROLOGUE: Doesn't Everyone?

PART ONE: Hugging 101

Chapter 1:Creating a Hugging Culture

Chapter 2:The New Business Landscape

Chapter 4:The Golden Principle

Chapter S:Hugging Is a Mind-set

Aa

The Principles of Passionate Customer Service

Chapter 3:The Customer-Centric Organization

2 | M

0% Location 1 of 3546

From the File menu select Exit.

B :

Trr Ware Sraeer Journai Busisess Besvsiiins

YOUR

CUSTOMERS .

eI MIET CIIELL
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Preview
E Kkenneth's Kindle for PC - (m] =
3 View »  or

File View Tools Help

Syne Fs
O Sync
New Collection ctri+N
;q
Import a Local PDF
Import Using Send to Kindle
cri+Q e

Epit
K

00V cottections

Hug Your Custome... :
Mitchell, Jack b

U ERRORES FATALES

0s
L& ] F

32.

33.

o=
3= Filter »

Secrets
Millionaire
Mind

of
I. Harv Eker

Secrets of the Milli... 3
Eker, T. Harv =

Tl Sortby: Recent »

Hedgehog's

Hexcellent
Adventure

Ever After High: Li...
Selfors, Suzanne g

MIRAGULOUS
MEDAL

Preview

Click Stop to stop the recording.
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34.

35.

36.

o oeskop >
Cong (mds)/Rootd725_... W Selectfle.. @ Proview
Oata 0 Select il x

Click byAccessibilityId("ReaderMaintindow. centraliidget . content.

byAccessibilityld("ListvienTten-") “Mitchell

yName("the two stores in Comnecticut, Mitchells and Richa

)
Cllck byAccesaibilityId(“Reader tenth_
Clik b bi1ityId("Reader)
Clik b bilityld tenth_
Clik b bilityld(Reader) e

Click byName(“Title Page")
Click byAccessibilityld(“ReaderMaintindow. centraliidget. ToolbarR_
Click byName(“File”)

Click byNane(“Exit")

Recordog

wease | Mgy | @

If needed you can edit your test script
accessor.

. For example, reordering an

S KindleVideo des ®
[{) save D Undo &8 Deskiop > RootDeskiopApp v

Config {mds}/Ro0t4725__.. M8 SelectFlle.. @ Preview

Double Click byAccessibilityId("ListVienTjten-8")

Double Click @ byAccessibilityld("ListVienIt.

byName("Kindle $5p
Xpahabsslde  byXPath(" /Pane/Pane[2]/List/L_
X byxe(117, 139)
Click BYACEE gq Accessors bntenth_
St Value Enter ByAGcessEbITIEyTd("ListVienTtem-&") "MItchell
Double Click byNane("the two stores in Connecticut, Mitehells and Richa.
AssertExists -
e <
Click byAceessibilityld(*ReaderMainNindow. centralWidget .content_
Click byAccessibilityld(*ReaderMainNindow. centraliidget .contenti-
Click byAccessibilityld(ReaderMainNiindow. centraliidget .contenti.
Click byAccessibilityld(*ReaderMainNiindow. centraliidget .content-.
Click byName("Title Page")
Click byAccessibilityld(* ReaderMaintindow. centralWidget . ToolbarR..
Click byName("File")
Click byName("Exit")

Readyto start

@ Record

» Play -

Click Play to play your test script.

The Preview window displays the playback while the corresponding
steps are highlighted in the Desktop Designer window.
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% appvance

Q - Preview

B Kinclevideo dds © NotSecure  https://ec2-100-20-219-14.us-West-2.compute.amazonaws.com:8443/UI/v1/#/preview

Preview
(9 Sve D Undo oo B Deskop >

Config (mds)/Roota725_.. W Selectfile.. ® Preview | [ I Kemneth's Kindie for PC

Data W Select i x| | File view Tools weip

+ Add Resour Q " Kindl O syne 2 fiter > TL

Double Click byNane(“Kindle*)

Double Clck

Library ~

Secrets
Books

Millionaire
focumens Mind Hedgehog's
Samples Hexcellent

v Adventure

Click byAccessibilityId(“ReaderMaintindow. cant
SetValue Enter byAccess 1011 tyTd(*ListViowTtams

Double Click byNeme("the tho stores in Connectl

&

00\ coutections ~

Assert Exists I. Harv Eker

Click byAccessibilityId("ReaderMaintindow. cent
Click byAccessibilityId(“ReaderMaintindow. cent
Click byAccessibi11tyTd(“ReaderMaintindow. cent

Click byAccessibility1d(“ReaderMainhindow. cent

El artede
cerrar
laventa

Click byName("Title Page")

Click byAccessibilityId(“ReaderMainhindow. cent
Click byNane(“File")

Click byNane(“Exit")
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API Testing

API Designer has been revamped with powerful validations, DPL support, and
more. This allows you create complex test scenarios in seconds, streamlining
your testing workflow and boosting productivity.

U X AP e ]

= AP > AP Testing [ r— >

Building Blocks
DATA FILE JiRA_Data_File = JIRA_Test_Datacsv Change File

« -
SELALEER

Enhancements include:

« Enhanced OCR Text Recognition: An advanced feature to get text from
an image. This is not available in in Postman.

e  Support for Data Files: Added data file support (aka DPL) is available in
API Designer like itis in the rest of the AIQ Designer suite.

e Global Header Section: This helps when the headers are repeated, but
only need to be specified once.

e Multiple Edit Features added: You can now copy and paste API
requests or import AP| Designer scripts.
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Locker Functionality: Allows you to use values in subsequent test cases
or iterations.

Basic Certificate Support: Now you can use Certificates for author-
ization purposes.

-95.-



API Testing

New API Testing Building Blocks

As part of the enhancements there are five new API testing building blocks.

Building Blocks
Click & black to add it to flow

Import REST

Import SOAP

Lira] a DlaCk 1o add it to fow

REST Request
SOAP Request
Validation

For Each
Condition
Data File

saL

Proxy

OCR

Global Params
Include
Locker

JavaScript

The following building blocks have been added in the AlQ 5.2.0 release.
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OCR Block

A new API building block is available in AlQ 5.2.0; an Optical Character
Recognition (OCR) block.

OCR ocrl =  response.body v

Returns String ()

lorem

ipsum

dolor sit amet
consectetur
adipiscing
elit

Aliquam
volutpat
auctor

O o~ o B Wk =

e Default name: ocri
 Has one input, accepts body from previous responses
e When itis empty is shows the hint “Image”

e Returns string of characters, recognized text separated by a newline
character

Global Parameters

This is used as a Global Header. In each block you can add one or more head-
ers that will be added to each subsequent request blocks.

SOAP Request

i v GLOBAL PARAMS ® i x
Validation

Parameters  Header  Authentication

For Each
+ Add Parameter
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#f v GLOBAL PARAMS

Parameters  Header  Authentication

No Auth

Basic Auth
Bearer Token

OAuth 2.0 Client Credentials

Include

You can include files with your API test.

INCLUDE FILE includel Select File

Locker

You now have the option to store the values of the results in a locker. This can
be extremely useful if you are creating scripts in one of the AIQ Designers or

Services Workbench, to allow you to store the data in the locker and reuse it
in any script.

i v LOCKER WHITEBOARD

-+ Add Parame ter

e \Whiteboard

o Parameter

e Key
e Value
JavaScript

Allow you to include JavaScript in your API test.
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JAVASCRIPT Select File o :
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Postman Conversion

AlQ introduces the ability to read Postman JSON files and convert them into
Service Workbench API (. swapi) files. This allows you to integrate and util-

ize existing Postman tests within the Service Workbench environment for your

automated testing.

Highlights

New interface: New Interface to visualize imported API Scripts

Import Feature to convert from Postman Scripts into SWAPI scripts
Implemented the most common Postman commands. Other commands
could be added quickly fast, in the rare case they are needed.

Playback of SWAPI files to execute them. get them executed.

Support for Scenarios, which means that you can add the SWAPI files into

Scenarios and save results in the Dashboard

Converting Postman Files

Opening a Postman file from Services Workbench initiates the conversion pro-

cess. The conversion process handles all key elements, including:

HTTP methods
Headers

Body parameters
URL parameters
Authentication details

Test scripts

One the Postman file is converted, you can edit the generated .swapi files

within Services Workbench. From there you can execute the generated

.swapi files individually or as part of larger test scenarios.
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Functional Changes

These are the various small changes to functionality that were made in the
5.2.0 release of AlQ.

CICD Git Dashboard Housekeeping

Implemented a parameter to determine the maximum number of days that
builds are retained. The parameter is maxDays and is shown in the below
code snippet.

<taskdef name="historyManager" classname="com.appvance.ci.git.HistoryManager">

<classpath refid="RestClientLibPath" />

</taskdef>

<historyManager
folder="${localEmptyFolder}"
product="${product}"
environment="${environment}"
executionType="scenarios"
maxDays="10" <<<<< days to keep entries
buildversion="¢{buildversion}"

/>

Removed Support for SoapUl

Support for SoapUl was removed in the 5.2.0 release of AlQ.

AISG - Creating Custom Actions

When you click on an unknown input on the actionable elements list from a
state page, a custom action with the selected element will be created.

User Management - Teams

An enhancement has been made to user management so that you can now
assign users to teams.
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& This function is only available to the Owner (appvance user).

Navigate to Global Options > Admin Options > Teams (tab).

Lab Management Results Network Emulation Notifications User Management Teams LoadRunner Jira License Certificate Reboot AlQ Services Activity Logs

SAML Options

AddNewTeam  ImportTeams  Export Teams

Team Name Date Created Members Team Description

Available functions:

* Add ateam

* Delete ateam

* Assign users to teams

* Remove users from teams
* Export teams

* Import teams

The import CSV file must contain the following five
column: User Name, Role, Team, Password, Confirm
Password

Delete Execution Reports

From the Reports screen you can now delete an execution report that you
decide is not relevant. This improves the ability to identify relevant reports
more easily by removing irrelevant reports. Deleting an execution report will
remove all information and related reports for the execution.
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Some situations where this could be useful is to delete empty reports that clut-
ter up the database. Empty reports are created when a scenario fails are one
such cause of empty reports. For example, sometimes during the process of
setting up a scenario, the scenario may play a number of times which gen-
erates a new report. However, when you open the report, an error occurs
because the scenario failed to run to completion.

API Testing Reporting

The Dashboard now shows detailed reports for APl scenarios similar to DS
and JS scenarios.

Timestamp Displays

The Star Session timestamp is now in human readable format. Also, a note
was added to clarify that the time stamps displayed in the text log should not
be used to calculate step durations.

Trace Logs v
10N, please TEIEr LU UIE SCILPU SHapsiuL Ul Ui AlldLyZe [EpUTLs
Starting session in —> http://localhost:9090/ds/dyn/
* Note: The following text log shows start times for each step. This times should not be used to calculate durations of the steps. To check on step durat
ions, please refer to the script snapshot or the Analyze reports.
Starting session 9390246 - 05/10/2024 22:24:13
Step 1:
Navigate to https://demosite.appvance.net/

Iteration Summary Reports Optional

A new CICD parameter controls whether the Iteration Summary Report is gen-
erated and attached to the report.html CICD Dashboard page.

This option allows users who are only interested in the Functional Reports of
their pipelines to decrease the time it take for the pipeline reports to be gen-
erated and reduce the stress on the results database. This can be a sig-
nificant saving of time and resources for scenarios with multiple iterations.

The parameters is includeSummaryReports. The default value is true,
which means the reports will be included. If it is set to false, the iteration
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summary reports will not be attached to and attached to the report.html
CICD Dashboard page.

Scenario Editor

The following functional changes in the Scenario Editor were added in AIQ
release 5.2.0:

e Added option for API tests in the Script Type for Bulk Performance tests.

DataDog APM Integration

When setting up integration with DataDog the parameter live=true must be
replaced with 1ive=false otherwise DataDog will only show the last 10
minutes.

See Integration with Datadog (APM) for more information on
the integration.
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AlIQ 5.0.x Enhancements

AlQ 5.0.x Enhancements

Depending on what AlQ release you are upgrading from to AlQ 5.2.0, there
may be additional functional enhancements included in this release.

Refer to the release notes for all the AlQ releases since your
current release for more details.

The following enhancements and functional changes were add in update
releases of AIQ in 5.0.1 and later 5.0.x releases.

Scenario Execution Data

Scenario execution time data older than 90 days will no longer be stored. This
will result in performance improvements because AlQ is no longer storing
large amounts of historical data.

& This change was introduced in the 5.0.1 release of AlQ.

Added Support for Encryption of JavaScript DPL
and Hash DPL

With this improvement, every time a Hash DPL or JavaScript DPL .CSV file is
saved using AlQ, the file will be saved encrypted by default. This improve-
ment is to increase user test data security. Existing unencrypted .csv files will
continue to work within scenarios and scripts along with newly created encryp-
ted .csv files.

& This change was introduced in the 5.0.6 release of AlQ.
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AlQ 5.0.x Enhancements

Added Add Encrypt/Decrypt DPL to Actions

Similar to the available actions of Added Hash DPL, Add JS DPL, and Add
Synthetic DPL in a test script, you can now Add Encrypt/Decrypt DPL as well.

[¥] save 9 Undo e & Chrome Ready to start ® b~ &
Data @ SelectFile..
Navigate To https://www.apple.com/
I Add Encrypted DPL  "{ds}/testEncr.csv” @ Select File sscscsssnsee: ® I

Click span(“Mac")
Click link(“globalnav-menubutton-link-search")
Set Value textbox(@, _in(div("globalnav-submenu-search"))) = "Apple ID support”

Result-url")

Click link(“globalnav-menubutton-link-search")

Improved Resource Management in Scenario
Editor

Improvements have been made to resources management in the Scenario
Editor. To make it clearer to users, the Test Cases panel has been moved
and renamed to Test Case Definitions.

The behavior of AIQ when removing a test case definition or resources has
been improved:

e If you remove a test case definition, the associated resources will only
be removed if they are not being used by any other test case definition
of any iteration.

* If you remove a resource, AlQ will inform you if that resource is also
used in another iteration or test case definition. If that is the case, you
will not be able to remove the resource.

& This change was introduced in the 5.0.6 release of AlQ.
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Enable Extraction from the Whiteboard within a
SQL Script

In SQL there are ways to store results in the locker, and now you can inject
items from the locker.

Sample Code in a Services Workbench Script

addToLocalWhiteboard("DefId", -1081701662);
processSQLFile(("readFromWhiteboard.sql");

var value = getFromLocalWhiteboard("DefinitionValue");
log("Definition value is "+value); // This should print 'Testcase’

|, & This change was introduced in the 5.0.6 release of AlQ. ]
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